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Basic operating instructions
PLUS-Solutions

This manual describes the general basic operation of the new "PLUS" programs of FRILO.

The PLUS programs are characterized by a "+" - in character after the program code (eg S9+).

User interface

Menu bar; Selection area and Input area
Hide / Show the left menu bar
Properties menu and input fields
Information area
Tip for beginners: Use the ENTER key!
Interactive graphic area
Ribbon bar

Input
Assistant / Wizard
Interactive-Graphic — Input options
Direct links / Text links
Context menu (general)
Context menu of single elements
Tooltips
Direct entry of values
Zoom, move, 3D-rotation

Graphics / Document — the view selection
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Ribbon bar

File tab

Start tab

Results tab 10
Data entry via tables - alternatives 11
Remarks Editor 12
Help - Hotline Service — Tips 13

In addition to the individual program manuals, you will find basic explanations on the operation of the
programs on our homepage www.frilo.com in the Campus-download-section.

Tip 1:  Back in the PDF - e.g. after a link to another chapter/document - use the key combination <ALT> + "Left
direction key".

Tip2:  You can find answers to frequently asked questions at www.frilo.eu under » Service » Support » FAQ.
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User interface

The central elements of the new PLUS programs are:
= Menu bar and input area (left side beneath Properties): can be faded_in and out using the pin-needle symbol.

= |nteractive graphic area

= Assistant

Ribbon (multi-function toolbar)
= Output document (View selection)
Quick Access Toolbar Tabs Ribbon

New item (Project 1B} - 57+ Portal Frame 01/21A (R-2021-1/P07

File Start Results ‘ @ (D Help~

. - = 1 Lkl N & B Sawe
= OB F L E @Y can @S R H =
E= il = L 1 S I £ P B
Basic  System Loading Design Search | Calculate Design Results KA AJ Code - v | Systern Load LoadCase iz Permansiit Document 3 Save Connected Old
parameter - e [ra and back programs * codes
Input Caleulation Graphics Visibilities Presentation Output and layouts FRILO Software ~

Propel_'ha ‘? Graphics Document
. Basic Parameters o &
: e Load Ca nanent - active E-

&
i Cross Sections DIN EN View selection

! ' Boundary Condtions Structural st . GraphiC VieWS / ’_J
3 o V\ esign mo Input-graphic/Output document

[#- Design

141 Output

Steel A

Type Structural stes! -

Grade 5215 e [ e — —

Characteristic values = T T e

System dimensions o = I v v 1 o
Roof shape Ridged roof - g , 1

Inpuit dimensions Outer dimensions i +—

Outer width il 25.00 Change cross-section >
Ridge distance left fml 1250 Inte raCthe graphlc Add support
Eaves height at left [m] 6.00 . g Add elastic foundation
T N o directly editable = )
Eaves height at right m 6.00 O values
Cantilever at left im} 0.00 Design using BTII+
Cantilever at right m] 00
Frame spacing m] & l
Posttion of frame Inner frame: 5 '
Thickness wall-/ roof construction (] El
Pitch 9 e,
Roof side left [ 308 Input area S
R - Input of data Interactive graphic
£ - -

fomat & - Selection options grap

aiouthz gy = context menu

(right mouse button)

The thickness of the wall structure can be entered

from outer edge column to outer edge of building

shell construction to improve the accuracy of the SERV Absolute (Beam haunch)

model k - 3y

3 71 Supports ] Standardloadcases | Additional Load Cases _ Tabs for table d|Sp|ay %

L1 help area/ info

Menu bar: Selection area and Input area

If the menu bar is not displayed on the left side, it can be displayed via the "Properties” tab — see the following
section “Hide / Show menu bar”.

All entries are divided into useful areas in the menu, e.g. Basic Parameters, System, Loads, Design and Output.
By clicking on a menu item, the corresponding input areas or the individual input parameters are displayed.
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Hide / Show the left menu bar

If the menu on the left is not displayed and
you want it to show, click on the "Properties"

tab on the left side. If you want to hide the File Start Results File Start  Resulis
fixed menu bar again, click on the pin symbol. =" . =,
gen cckonthepnsymtol | g 5w o vyl ze 2 | = @
FRILO recommends interactive input in the M Q ERC] ” : 41 Q = ;
. . . Basic Calculate Design Results Basic Calculate Design
graphics window as the usual input type. parameter B e
e ‘( Calculatio
Pm_perties n T i Document
IJ E‘.asic parameter Qo g—_ 343 E Hh ®-0
T | | Paces Bockmatks
= |~ ‘ 2
==
Properties menu and input fields
Use the items or sub-items of the menu to select the entries to be edited Properties ?
intheinputarea. '
P [+~ System Qe
Sub-items (recognizable by the preceding “+” sign) open when you click - Loads
on the “+” sign. - Design
. . . ' . - Output
The input area contains the input fields for data as well as options and
selection lists. Design Standards and Safety Concept (4]
Individual input sections that are rarely needed are often "collapsed" for Design Standard MM DIN EN 1983 -
reasons of clarity and the space available. These can be accessed by w2for crane loads 0.30
Lo y X Snow as accidental loads
clicking on the ~ —Unfold icon. :
Load factor for accidental snow 230
w2 = 0.5 for snow (AE} Ll
Information area Location in windzone 3 or 4 [
L . . o . Equal vG for all permanent loads
As soon as you click in an input field, a description of the input value 2
. . . . Ultimate Limit State &
appears in the help and information area (below). The same explanation
also appears as a tool tip when the mouse pointer pauses over an input Serviceability &

field.

Tip for beginners: Use the ENTER key!

Defines that - in addition to all ordinary design situations
- snow loads shall be also considered as accidental
loads.

Each ENTER takes you to the next input field. In this way you can go through the item input with the sequence
"Input - ENTER - input - ENTER etc. - without having to use the mouse. You can activate/deactivate options
with the space bar, you can also open selection lists and navigate in them with the direction keys.

Interactive graphic area

In addition to the customary definition options in the menu/input area, you can also enter particular values in
the graphical user interface and edit them there. The GUI allows you to edit data on the spot by simply clicking
onto the corresponding value or by use of the contextmenu (right mousebutton).

See also Interactive-Grafic — Input options.

Ribbon bar

The so-called Ribbon bar is a graphic operating concept known from modern applications (Microsoft Office /
Autocad ...) that connects menu control, toolbars and dialogs with one another.
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Input

By default, the input begins with the Assistant (formerly named Wizard).

The further entries are then mainly made in the interactive graphic — but you can use the the left menu bar
alternatively/simultaneously — see "Showing and hiding the menu bar".

Assistant / Wizard

The use of the Assistant (formely known as “Wizard”) is the fastest way for the initial input of an item.
If the default settings are unchanged, the assistant dialog appears automatically when the program starts.

Only the most important, basic system data is queried in a compact form. Then you can compute this basic
system and afterwards you can set up the details.

How to disable the assistant: option in the assistant window or » File » Program options.

Accistant

y

Create new structural item

o e
Assistant Templates Open
System
Truss system Double
Length [m] 10.00
Left height [m] 2.00
Height [m] 3.00
Right height [m] 2.00
Span 4
ivision of the spans constant span length T
Girder spacing [rn] 3.00
Top chord | default C5) HEE 200 = T
Bottam chord (Standard CS) HEE 200 = n’
Post (default C5) HEE 200 =
Diagaonal struts [ default C5) HEEB 200 g '
Boundary conditions
Wind and Snow Load o | _— T
Activate/deactivate the Assistant
Starts assistant to define the truss system.
Always use the Assistant to create a new item QK Cancel

Templates: an item template can be chosen as the starting point for a new item. A template can be created
via » File » Save as" » Option "Use as template" or via the item context menu in the FRILO
Control Center.

Open selection list with the items last used.
"Others..." button: Display of a window with the last used project.
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Interactive-Graphic — Input options

The interactive graphic is the usual type of input with newer program versions.

Direct links / Text links

Graphics Document

For the most important general information, click on the text

links. The corresponding dialog is then displayed. These links PCCf lc'ad_. o )
also provide information about the essential defined & _”'”'Er- U'”'_Er spacing: «Lum Text links
parameters - e.g. the selected standard is displayed - the with Snow / with Wind

dialog behind it usually has additional parameters. DIM EN 1835:2073
This gives you an overview of the selected values at a glance. | Softwood

Material - Click to start Properties-Dialog i

Context menu (general)

. . . . . . View ¥ Zoom
Right-click in an empty area in the graphics window. bacic Paramt Al
. asIc Farameters
The general context-menu (see right) offers a number of Move
. Syst: ¥
standard functions. yerem oo
lewis Zoom out
Context menu of single elements select load case " Rotste
Standard load cases ¥
: H H Additional load cases ¥ Default view
When moving the mouse over the different elements in the p— T oy
drawing the mouse pointer changes his style and the element Design . hh || Frontview
. . . ave gra Ics - .
will be marked in a different color. Output r :'e“‘f“’"‘ Lehind
i op view
When right-clicking the appropriate context menu appears. | Bottomview
X i i View from right
Double click on an element: opens the properties dialog of the e T
element directly.
Tooltips
When holding the mouse cursor over individual
graphical elements tooltips will show up. View >
Mew 3
Basic Parameters
Direct entry of values Ahilpue :
Soil properties
Input fields are activated by clicking on the Ground water
respective value. Surface
Example: The dimension is interactive, that is Uhccks soll catbecnng
. ign . 3 Settings
you can click on a measure and then change R Pzt:d:ng
the value. The change is also visible in the : R emaat

leftsided input area.

Zoom, move, 3D-rotation

Use the mouse wheel for zooming in and out. —
Move the picture by pressing the right and left mouse button and moving the mouse. T
For 3D-rotation hold down the right mouse button and move the mouse.
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Graphics / Document — the view selection

Graphics /Document tab: switch between input mode (graphic window) and the output preview (PDF).

The interactive input graphic is automatically displayed after the program starts.

The scope of the output can be defined via the Output menu item - this output profile can be saved in the
toolbar » Output and layouts section and reloaded if required.

If you click on this tab, the output document is displayed in PDF format.
If the position has not yet been calculated, you will receive a corresponding message.

The functions of the symbols for saving, printing, navigating in the document, searching PDF etc. can be
shown using tooltips. According to the usual functions of PDF display programs such as Acrobat Reader etc.

See FRILO Control Center » Page layout

il 5 ) & we oo New item (Project: SB) - FWH+ Trusses Timber 01/, -2021-1/P02)
=
File Start Results @ DHelp~
= = T |~ e o h7ak s %) B Save
= O3 F L & @Y caa B &=L i R =
R : Roof load - 4 Pl e Lo
Basic  System Loading Design Search | Caleulate Design Resufs | . s 3 Document "= * Save  Connectsd
parameter [ 7 w5 =% | and back programs ™
Input Calculation ] Load Cases Output and layouts FRILO Software ~
| Properties R | Graphics = Document Saves the cumently selected output layout
.. Basic parameter Q& p S RHC S 87.5% ® @ B @ pa 1 4 @ p o = @ i i ;
‘ - @ % - D@t @B @-©- DEADE [O]A® swpge
o W@t B0 @ i
i Loading Pages  Bookmarks T B B - S B I S R B S R R B - R N B R BT SE TR ' -
- Design
= FRILO Software GmbH Frojekt - ({//
Stuttzarter St 40 Tel.: +43 711 810020 Position: [ New itam) -
General ] bl 70469 Stuttgart Fax +49711 8100230 12/10/2000 Seite: 1 §
Brief output N
Notes O & Position: (New item)
System e
i 2 i Trusses Timber FWH- 01/2021 (FRLO R-2021-1/P02)
System graphics 20 -
System graphics 30 O 4 Basic Parameters
Force the scale 0O : Design code DIN EN 1595-1-1/NA:2013-08
5 Basic EN 1695-1-1/A2:2014
Loads () Safety concept / load combinatorics DIN EN 1990/NA: 2010-12
L U= 05 for snow [AE) not considerad
Actions - Permanent loads all egual v (Ve OF Vo)
- CLED ati wind Average of shortand very short
Load Case Graphics Deta
Results (~] < Material code BN 333:2016
Support resction- characteristic perload case . e RS 2 o fosdl e
Result Graphics Deta i st delectan w ﬁg
Resulting irtem forces in table Deta - Voo
7 System Double hip truss
B by = ~ +
o]
—— [\ —
i ' ™ = _7'| b
) %, 4 8
3 e = -
o =i ™ e
Page 4 _ = N 3
= . .
= ‘ ~ =
- . p . . v
< >
] Listofbars Topchord | Listofbars Bottomechord | ListofbarsPost ] Listofbars Diagonal struts ] Standard Load Cases | Additional LC X
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Ribbon bar

New item (Project: Stahl) - S7+ Portal Frame (x64) 01/23 (R-2023-1/P02)

File Start Results Help ]
4 bbb B -—
= oo F P E QN aee/gEs obes | L)
— — — & = | L L A - P e Los i
Basic  System Loading Design Search | Calculate Design Results A A iﬁ Code i I-” System  Load LoadCase & Feemancat Document 1 Save Connected Old
parameter -  |Cases Il B4 Manage | and back programs ¥ codes
Input Calculation Graphics Visibilities Presentation Output and layouts FRILO ~

The multi-function toolbar referred to as ribbon was introduced by Microsoft in the Microsoft Office 2007
version.

It is characterised by an operating concept that combines the control via menu items with buttons of a
toolbar.

Instead of menu items or menu bars, tabs such as
- File,

- Start or

- Results

are available.

A click on one of these tab options displays the associated function buttons (below), which are arranged in
command groups in view of the task to be accomplished.

By clicking on the small buttons with the v symbol, you can display LiLl

additional functions. N ice oy

e - A
This is a typical control of new Microsoft interfaces, but in FRILOPrograms it s""fem CLDad
is only used in a few cases. o ]
System in wireframe graphics
If you click on the upper half of the symbol, the standard function is called
up. The lower half of the icon will become a selection list with more

functions displayed.

Systemn in 30 rendering b
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File tab

Usual standard functions.

Ill. right: File tabs in newer / former presentation

New

Open

Save

Save as

U
=.
>

—

Import

Export
Close

Windows Layout

Create a new item. You usually use this j e
function. already in the
FRILO Control Center. "/ oo
Open an existing item. '
Projects and items of the project folder H Save
last used in the FRILO Control Center
are displayed. ‘a Save As
Save the opened item under the existing _
item name. If the item has not yet been Save as ,’5} Print
named, "Save as" is carried out.
Like "Save", but with explicit Print » J Import
specification of an item name and - if
necessary - selection of a project. Import *r ; Export
Printout of the output document on the o [k
. . Export a
set printer. If the calculation has not yet ] Cose
taken place, you will receive a
. Close ﬁ
corresponding message from the & Program Options
program. o
Settings
Import of e.g. ASCII data sets or Frilo Exit

XML.

Export of items as e.g. ASCII data sets, Frilo XML

The item is closed.

resets the window settings and restores the default state.

New Item when setting up a new item, an assistant supporting the user in the basic definition is
launched by default. You can optionally disable the assistant.

You can also disable the automatic computation which is launched each time you enter
or edit a value. Disabling is recommended when you are using a slow computer.

Graphic allows you select a colour setting (light / dark).

Units allows you to configure/edit the units/measures (mm, cm, m, kg, kN ...) used in the
software.

Automatically collapse the input tree In the left-hand menu tree, the expanded menu items are
automatically collapsed when another menu item is clicked (default) - if the option is not
selected, these menu items remain expanded.

Exit This closes the program. If changes have been made to the item and not saved, you will

be asked whether the data should be saved.
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Start tab
File Start Results Help
= e 1 T 12
The available functions correspond to the menu items in the left = Qg T U & F

Basic  System Loading Design Search | Calculate Design Results ) Code

sided menu bar. parameter

Input Calculation Graphics Visibilities

Properties n
+ Basic Parameters o
i System
- Loads

— Search

|conned\

Boundary Condtions / Column connection at left Coy

Input fields can be searched for using the magnifying glass

Max / Min shear values

Connections Boundary Condttions # Column connection at right Copy

symbol or the F3 key- : Advanzted Stabilty Analysis e Ciection e

. . . -0
Example: Where is the input field for the roof load? o i e o B e o et
. I " " . . Design of Ultimate Limit State ~]

Click on the magnifying glass, enter "roof" and all input fields that | cimee  Desgnmecentsgry < | o o/ Comestion beam scried en supoar
contain the word "roof" in their designation are listed. A click on Remarks y || Frome Camer/ Connecton-beamo coumn - welded
... about the resufts = Frame Comer / Connection beam welded aver support

one of the listed entries and the corresponding entry is displayed.

You can start the calculation explicitly with "Calculate”.

Auto on/off is a switch that enables automatic calculation after every modification (not recommended for
processor-intensive systems).

The status of the verification is displayed via a sort of traffic light.

Under "Results" you will find program-dependent functions for the graphic display of the results.

The button in the ribbon bar (calculation group) indicates with different traffic light colours iy
esign

whether the verifications have been successful.

- Gray indicates that the system is "not yet calculated".

- Green indicates that all verifications have been successful.

- Yellow indicates that permissible values have been exceeded or constructive problems have occurred.
- Red indicates that the verifications of the bearing capacity are not met.

By moving the mouse cursor over the traffic light button, a tool tip with the most important utilizations is
displayed. Clicking on the button displays a window that shows tips concerning exceeded limits and warning
notes in the corresponding situations.

The options for the graphical representations are explained by the tool tips (move the mouse cursor over a
button and wait a short time until the tip is displayed).

Various program-dependent options for displaying the system, dimensional chains, loads, etc. If these are not
self-explanatory, they are explained in more detail in the relevant manual.

The interfaces to other FRILO programs are listed and can be called up via the "Connected programs" icon.
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Results tab

The Results tab displays the functions for displaying the result graphics. You can display the explanation of
the individual functions as a tooltip (briefly persisting with the mouse). If separate explanations are necessary,
they are described in the manual for the respective program.

FUH B E [%] 0w = New item (Project: SB) - FWH+ Trusses Timber 0172021 (R-2021-1/P02)

File Start Results O @Help~

Rt L | r“—“-,x—‘] — 11-] T{] rn
| 1 i

Decisive Load LUSIRGED {perssimotitransientl:Ha & Load N My Qz spatial n.longi.tudinal r].sHear n.sta;bility
Combination ~ force

View Loads Inner forces Deformation Dimensioning o~
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Data entry via tables - alternatives

For the entry of data represented in tables, the following options are available. The load case table is taken as
an example to demonstrate the options.

1. Accessing tables via the table button (or the corresponding tab in the graphic window) and entering data
directly in the table cells.

2. Entering data in input fields in the FDC area by accessing the individual rows of a table via the table
toolbar.

Note: You can also alternate between the two methods of entering your data.

The functions of the table toolbar demonstrated by the example of the load case table:

Additional load case 0 28 @ laxEB S
Table name Row navigation Insert Delete Delete tabledata Access table  Confirm
23

indicates the row number: The first number indicates the currently active row, the second one the
total number of rows.

N jumps to the next row upwards: the previous row is enabled and the values are displayed in the
corresponding cells.
o jumps to the next row downwards: the following row is enabled and the values are displayed in the
corresponding cells.
Leh

inserts a new (empty) row below the currently active one.
deletes the currently active row.

delete the entire table contents.

[B:] [E] >

accesses the table, which is displayed in a traditional way and you can enter values directly in the

cells.
]

confirms the entered values.
Loads @ * |Load Cases
Load Cases 0 2 © » = :"l.:_|

. e 4 Nz | it | il | iyt [ gttt [ [yt [y | i [ T3] B3 T Ty T
Column loads LA [kN] l'r:\[:‘ [rl:\[]ﬂ [rl;['ll [:_’I]\J [nD | e | ey | et [m] [:‘[;J{ [:‘I‘:l]a
Description 1000 | 0.00| 0.00| 0.00| 000| 00| 00| 00| 00| o0 140| 1.40|0.00| 0.00| D.0D
Vertical Force in 2 Lal 0o - =& | 0.0|000| 000|000 000 0.0 0.0| 00| 00| 0| 140 1.40|0.00( 0.00( 0.00

1000 | 0.00 0.00| 0.00| 0.00 00| 00| 00| 0| 140 140|000| 000|000
| Groundlayer 5] Load Cases —| Single

Input section showing the values of the currently active table row.

Representation in form of a table (accessible via
the table button or the corresponding tab).

FRILO Software GmbH 04.11.2024 Page 11



FRILO

////\\\\

Manual Basic Operating Instructions for PLUS-Solutions

Remarks Editor

Up to the 2020-1 release, remarks on positions, loads, etc. could only be saved as text.

Starting with Release 2020-2, the Remarks Editor can now also be used to carry out various formatting or
insert graphics and tables or special characters.

The remarks are inserted in the output document.
The operation is intuitive and takes place as it is usual in word processing programs.

FRILO Remarks Editor

[y
WG AL e O BRI B
iZ iz
Save | Paste E@ Caption Tk i Extra Table Image Saved
and exit Characters Snippet
Save Clipboard Format Font Paragraph Paste ~
With the Remarks Editor you can format your comments which are included in your cutput document.
You can enter special characters like o, B, 3 ...
Superscript text: x2, x;
Include tables:
Headrow
Rows and columns
Include Graphics
AMNEMETSCHEK COMPANY \
I
< >
FRILO Software GmbH 04.11.2024 Page 12



Manual Basic Operating Instructions for PLUS-Solutions

FRILO

////\\\\

Help - Hotline Service — Tips

Under the menu item "Help" you will find the “Manual™link and depending on the programme, further
supporting functions such as links to suitable video tutorials or a link to our section Frequently Asked
Questions (FAQ) on our homepage. You are also welcome to send us ideas, wishes and your personal opinion
about our programmes via the “Give feedback” function. In the "Information" section you will find the
programme version as well as update, patch and release information on the programme status.

FRILO Control Center (x64) - 02/2023 Release <R-2023-2/P0Z2>

& Folder Projects ltems

Programs

Customer number: <8823 Server; <S0LCE 4.0 fA Styles ~

Extras Help

A Eeo®EH QORBRBR

Manual Manual FACQH
FCC  page layout

Group Help Contact

Here you can send a support request
directly by e-mail. This will save you
waiting time on the phone. Please enter
the subject of your enquiry (e.g.
installation, question about dimensioning
in the PLT programme, etc.) and a short,
clear description of the problem under
“Remarks:”.

You can attach a file via the "+" symbol (a
corresponding dialogue for selecting the
file is displayed) or a screenshot (a short
instruction text is displayed when you
click on the camera symbol).

Attach an item

In many cases, it is useful to attach the
item to the mail so that our support can
understand the problem. To do this, right-
click on the item in the FRILO Control
Center and select "Contact Support". You
will receive the same support request
window as described above, but the item

file will automatically be added to the mail.

Our hotline can also help you directly on your PC via remote maintenance using the popular TeamViewer
software. Of course, this must first be arranged with our hotline on the phone.

Contact Start Give
support TeamViewer feedback

Above Update Patch Release
FCC Info FCC info info

Information ~

é&h Send a web support request to FRILO Software GmbH — x

Customer contact: | Please select a customer cantact V

Topic: PLT - printing the title block
Remarks: | have defined my own title block template and am having problems
printing it out.
Attachments: M Frilo.Screencapture_17_05_2023-025033.jpg 1281KE | &b
<l

Add item file

(%) Additional Infos

I'm accepting the transmission of the shown data
here.

| Send | | Cancel |

=

Start
TeamViewer

FRILO Software GmbH
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